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About FlipBook Creator Pro 

FlipBook Creator Pro is a much professional 

program to help you convert ordinary PDF files into 

stunning booklets with amazing page-flipping 

animations and sound! Besides original classical 

Flip PDF features such as adding background 

images and sound, FlipBook Creator Pro also 

provides more powerful and professional 

functionalities, like embedding video, audio and 

links into your flipbook pages, exporting defined 

templates and settings to theme for later easy 

using, using command line to automate the 

creation of the flash eBooks without opening the 

Windows desktop application. 

 

 

 

 

 

 

 

Note: This product is distributed on a "Try before-you-buy" 

basis. All features described in this documentation are 

enabled. The registered version doesn't insert a watermark in 

your generated page-flipping eBooks. 
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Product features 

1. Convert PDF to Adobe© Flash® based page-flipping eBooks. 

2. Output in 4 different formats: HTML, EXE, Zip and Burn to CD. 

3. HTML allows you to upload to a website to be viewed online. 

4. EXE and Zip allow you to send to your user by email to be viewed on 

their computer. 

5. Burn to CD allows you to burn to disk so you can send your user 

physical media for viewing on their computer. 

6. Preview the output effect instantly. 

7. Batch convert multiple PDF files to a single or multiple page-flipping 

eBooks. 

8. Import bookmarks (outline) with PDF, and edit them manually. 

9. Including hyperlinks with PDF, include web link, page link, email link. 

10. Import text and search imported text with user-defined search terms. 

11. Provide multiple templates (default provided or download from 

website). 

12. Set eBook size, choose landscape or portrait. 

13. Watermark your page-flipping eBook using text, images, dynamic 

date/time and more. 
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14. Define titles, keywords and other metadata. 

15. Define titles, icon, window size for EXE page-flipping ebooks. 

16. Define book margin size manually.  

17. Add encryption to protect created page-flipping eBooks. 

18. Retain the book to center or not. 

19. Insert background music, always play or define times. 

20. Set background color, image or flash. 

21. Set book reading from right to left (such as Arabic). 

22. Choose hard cover for eBooks. 

23. Set page-flipping time to be manual (reader-driver) or automatic (as 

you design). 

24. Customize toolbar buttons to set permissions for downloading, printing, 

sharing and more. 

25. Set colors for toolbar, book cover, book shadows, bookmarks and more. 

26. Set font color, type for windows and bookmarks. 

27. Set scale for zoom-in function. 

28. Set control bars to "show" or "hide" in full screen. 

29. Define language for flash. 

30. Edit pages with links, videos, flash or sound files. 

31. Export and save settings for future uses. 

32. Save themes to make future use easier. 
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33. Save current files and settings as project. 

34. Provide command line version. 

Page-flipping eBook features 

With the page-flipping ebook you have created, your user will be able to: 

1. Drag the corner, click page shadow or use arrow keys to flip a page. 

2. Input login password to view eBook content. 

3. Auto-view flipbook repeatedly. 

4. Pre-loading of pages allows first pages to open quickly, viewers does 

not need to wait until all pages have loaded. 

5. View page thumbnails. 

6. Use button to control page, such as Previous, Next, First, Last etc. 

7. Flip pages automatically. 

8. View page-flipping eBook full screen. 

9. Search whole eBook. 

10. Print out the whole eBook or a range of pages directly. 

11. Download the uploaded page-flipping eBook from web site directly. 

12. Double-click to zoom in or zoom out. 

13. Links are still "live" and can be clicked to view after zooming in/out. 

14. Share eBook URL via email. 

15. Turn on or turn off the page-turning sound. 
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16. View video, flash or play sound file inserted in the pages. 

17. Open to a certain page in Browser by adding a suffix like this: 

index.html?pageIndex=4. 

Quick Start 

1. Launch the application via the desktop shortcut ; 

2. Click the "Import PDF" icon  to enter into Import PDF interface; 

3. Click icon to choose PDF file from your computer; 

4. Click icon to enter into template setting interface; 

5. Define parameters for eBooks, such as Book, Tool Bar, Bookmarks, and 

then click the "Apply Change" icon ; 

6. Click "Convert to Flipping Book" icon to enter into Output 

interface; 

7. Choose Output Type from HTML, ZIP and EXE, here take 

as example; 

8. Click to set Output Folder as "C:\flipbook", input File Name 

as "demo"; 

9. At last, click icon to output created page-flipping eBook. 
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You can open the "flipbook" folder in "C:", there are three files in this folder: 

 

 

Open the "demo.html" file to view your created p00age-flipping book via Web 

Browser, such as Internet Explorer, Google Chrome, Firefox, etc. 

 

 
 

Interfaces 

There are some main interfaces you will see while using FlipBook Creator 

Pro as below shows: Application Options, Import PDF, Template 
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Settings, Edit Pages, Language Option, Export Theme, Output, Batch 

Convert and Command Line. 

You can enter into each page to get clear instructions for every detail 

option. 

 

I. Application Options Interface 

Render Engine Option 

 

FlipBook Creator Pro provides 3 different render engines for you to create higher 

quality page-flipping eBooks, click "Options->Application Options" to enter into 

"Render Engine" interface: 

 

  

 

SWF: Much legible characters, smaller output size 

GPL Ghostscript: Higher color transfer quality 
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Inner Library: Faster convert speed 

(Change option when PDF imported failed) 

II. Import PDF Interface 

 

Panel Description: 

1. Source PDF File:  

 Click this icon to open the PDF file you want to convert; 

 View content of added PDF file to clarify before converting. 

2. The Page Ranges to Import: 

 Convert all pages to page-flipping eBook; 

Convert defined range page; 

 Just preview effect on first 10 pages. 



PDF to Professional Page-Flipping eBook Utility 

User Document 

Copyright 2010 by flippagemaker.com 

- 9 - 
 

3. Watermark 

 Add image or text watermark to flipping pages. 

Check this option first to choose default stamps or add new ones: 

 

4. Page Quality 

There are five types of "Quality And Size": 
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5. Other Options: 

 

 Select this option to use first page's 

proportion as book proportion, or you can define in Template Setting interface; 

If your PDF file contains bookmarks, check this option to use in output 

page-flipping eBook; 

If your PDF file has links, check this to enable in flipbook; 

Check this option to enable search functionality in created flipbook. 

 

At last, click  icon to enter into template setting interface. 

III. Template Settings Interface 

 
FlipBook Creator Pro provides three different templates at present: Classical, 

Float and Spread.  

Each template contains some unique settings, the below instructions will 

show you details. 
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The design setting interface contains below main parts: 

Choose Template 

Book 

Sound 

Tool Bar 

Initial Show 

Bookmarks 

Links 

Language 

Security Settings 

Font 

 

Panel Description:  

1. Choose Template 

 

 

Click icon to select templates from below interface: 

 

 Click this icon is to save current settings as a TXT file for later uses; 
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 Click this icon is to import stored setting file at once. 

 

2. Book Panel 

 

 

(1) Book Title (only can be set in Float Template) 

 
Customize book title for showing on the top of your flipbook. 

 

(2) Hide Book Frame Bar 

 

If don’t want to show the book frame bar, choose “Yes” in this option. 

 

(3) Retain the book to center 
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If you select “No” in this option, the eBook will be shown on the right-side. This setting is for 

embedding special background image, such as advertisement or company log. 

 

(4) Book Proportions 

 

Please note that the values are not fixed in pixels or inches, they just represent a ratio for 

"Page Width: Page Height", and the book size will be changed depend on your Explorer 

Window Size. 

 

 

(5) Book Margin 

  

A. Book Margin (set in Classical Template): 

 

"Book Margin" refers to the distance between the book and the toolbar. 

 

B. Top/ Bottom/ Left/ Right Margin (set in Float/ Spread Template): 
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(6) Flash Window Color 

 

This color will be applied on all flash windows, such as the book window, "Help" window, 

"Print" window and so on. 

(7) Page Background Color 

 

When load pages, or if the page number of your PDF file is odd, then the page (the last page) 

will show with the "Page Background Color". 
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(8) Page Shadow 

 

The value also takes the value of Book Proportions as reference, and the value interval of 

"Page Shadow Opacity" is "0~1", the larger value refers to the deeper shadow color. 

(9) Background Config 

 

A. Background Color:  

 
Define background for your flipbook with gradient color or pure color (the same color for 

"Gradient Color A" and "Gradient Color B"). Gradient Angle is the angle between the two 

colors. 

 

B. Background Image setting in Classical and Spread templates: 

 

Click the icon " " to choose background image from your computer, and there are 11 kinds 

of "Image Position" for you to choose: Scale to fit, Fill, Top Left, Top Center, Top Right, 

Middle Left, Middle Center, Middle Right, Bottom Left, Bottom Center and Bottom Right.  

 

C. Background Image setting in Float template: 
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The Float template enables you to add two background images: Outer Image and Inner 

Image. You can make Inner background image to show special information, such as 

advertisement or company logo, etc. There are also 11 kinds of "Image Position" for you to 

choose: Scale to fit, Fill, Top Left, Top Center, Top Right, Middle Left, Middle Center, Middle 

Right, Bottom Left, Bottom Center and Bottom Right 

 

(10) Right to Left 

If the language of your file is read from right to left (such as Arabic), then choose "Yes" in 

"Right to Left" option: 

 
 

(11) Hard Cover 

If you want create hard cover effect (a book bound with rigid protective covers) for your 

flipbook, choose "Yes" in "Hard Cover" option: 
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(12) Flipping time 

Sets page flipping time in seconds according to your 

needs. (Recommended second value is 0.6) 

 

3. Sound Panel 

 

If you want to add background sound to your flipbook, such as a song or other audio file, set 

"Enable Sound->Enable", then click " " icon to choose "Sound File" from your computer, 

then set "Sound Loops", "-1" stands for playing the sound file all the time while viewing 

flipbook, other value (N>0) stands for the times of playing the sound file. 

 

4. Tool Bar 

 

 

(1) Tool bar (only in Classical Template) 

 Show or Hide Tool bar in created flipbook. 

(2) Icon Color  
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(3) Zoom Config 

 

To Enable Zoon In functionality, choose ''Yes" in "Zoon in enable", then set "Zoom Scale", the 

value is the times between zoomed page size and the current page size. 

(4) Print Enable 

 

Choose "Yes" in "Print Enable", then click icon  to set print page range as below: 

 

 

(5) Search Button 

 

Select "Show" in "Search Button" (make sure you have check "Enable Search" option in 

"Import PDF" interface), then define "Search Highlight Color", after clicking "Search" icon 

, you will see a popup box to input search words, then click Enter or "Search" button, 

you will get the below searching result: 
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(6) Download setting 

  

If you want your flipbook readers to download the PDF file or the flipbook directly from your 

website, select "Yes" in "Download Enable" option, then input the Download URL directly, 

you can use absolute path like "http://www. flippagemaker.com/FlipPDFDemo.pdf" or 

relative path like "/files/download/FlipPDFDemo.pdf" (make sure you have uploaded the 

PDF to the same path). 

Then readers can click the icon  to download your uploaded PDF file directly. 

(7) Full Screen 

To enable "Full Screen" functionality in output flipbook, select "Show" in "Full Screen 

Button" option:  

Then you can click icon  to view flipbook in Full Screen, click icon  or "Esc" 

button to exit from the Full Screen. 

Or if you want to show your flipbook without Tool Bar while showing in Full Screen mode, 

you can set "No" in "Full Screen without Tool Bar" (just in Classical Template): 

 

 

(8) Help Button 

To show tips about viewing flipbook, you can set "Show" in "Help Button" option:

 

Then you can see the button  and click to get the tips as below: 
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(9) Share Button 

If you want your flipbook viewers to send the link to their friends or clients, you can add a 

share button in your flipbook for readers to send out your flipbook link immediately: 

 

When the viewers click the share button , they will enter into the Email interface with 

the link of your flipbook in the Email body. 

 

(10) Home Button 

You can add a Home Button  on the toolbar to enable readers back to your home 

page after viewing your page-flipping eBooks: 

 

(11) Auto Flip 

To auto flip your eBooks, you can set "Yes" in "Auto Flip->Enable" option; then define the 

Flip Interval (seconds of staying on each page); the value of "Play Count" stands for the times 

of auto playing the eBook, and "-1" stands for playing forever (after clicking the Auto Flip 

button , the flipbooks will be flipped by staying 3 seconds per page); if you want to 

auto start and flip the eBook after opening, just set "Auto flip when start up->Yes": 

 

 

(12) Tool Bar on Top (set in Float Template) 

If you want to place the toolbar in Float templates on the top of the flash eBook, you can set 
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"Tool Bar on Top" as "True":  

 

 

5. Initial Show (set in Float/ Spread Template) 

You can show Bookmark panel or Thumbnails panel on the flash page at the beginning, just 

select "Bookmark" or "Thumbnails" in this option: 

For Example, select "Thumbnails":  

Then you will get flipbook shown with below initial interface: 

 

6. Bookmark 
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In "Design Setting" panel (only in Classical Template, in other templates, the colors will be 

adjusted automatically based on your defined flash window color), you can set "Font color", 

"Background color", "Background alpha" (refers to the background opacity, value interval: 

0~1, "0" stands for the background is totally transparent), "Always Show Bookmark->True/ 

False" and "Panel Position->Left/ Right". 

In "Bookmark" panel, if you didn't check "Import bookmark" option in "Import PDF" 

interface, or you want to create new bookmarks for your flipbook, you can add bookmarks 

even sub-bookmarks here, click "Add" icons and then input "Title" and "Page". 

When click the bookmark button , it will popup the bookmark panel immediately, and 

click on those bookmarks, it will jump to the defined page automatically 

 

7. Links 

 

If you have check "Import links" option in "Import PDF" interface, or add links in "Edit Page" 

interface, then you can define settings here, choose "Mouse over color", "Link alpha" (refers 

to the link area opacity, value interval: 0~1, "0" stands for the area is totally transparent), 

and "Open Window->Blank/ Self". The links also can be clicked after zooming by setting 

"Enable after Zooming in->Enable". 

 

8. Language 

  

You can set language for showing tools or tips in your created flipbook, and here is the 

specialized instruction page for setting the "Language Option". 
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9. Security Settings 

 

If you want to protect your flash books with passwords, you can click "…" icon to enter into 

"Flash Security Config" interface: 

 

 

Select "Security Type->Single Password", and input passwords into the box (there is no 

restriction on password format at present). You can also set "Protect Page Range" as "All 

Pages" or the latter pages after a defined page number. (Tips: The program utilize RC4 

algorithm to protect eBook pages, the eBook content pages will show nothing without 

permission.) 

10. Font 
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If you want to change fonts of toolbar buttons, flash windows even bookmarks, you can set 

font types and colors in Font Panel.  

 

11. Export Theme 

 

If you want to save the current template settings as your own style template for later uses, 

you can click "Export as Theme" button  to storing all current template 

settings, include the background images, margin values, toolbar buttons and so on. 

 

Then when you want to use later, just click "File->Import Themes", the theme will be added 

to the templates selecting interface. 

 

IV. Edit Pages 

Now you can use FlipBook Creator Pro to edit imported pages directly, no matter you want to add 

link, video, sound or image file.  

Just click "Edit Pages" button  to enter into the editing interface: 

 

 

You can insert links, images, sound files and movies to the pages as you will. 

1. Add Link: 
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Click the icon  and then draw a link box on the area you want to add link, then define 

properties in below panel: 

 

 

 

You can define the link action as "Go to page", or open an online webpage, or even "Call 

Javascript function" to carry out your wanted interactive functionalities via defining Javascript 

function yourself.. For example, you can show a pop-up light box while readers clicking some 

image on page, or pop-up a questionnaire or other Web Form by clicking some text. 

 

Just make sure the parameter you set in "Function" can be called in from HTML page. 

 

Example: 

 

Check "Call Javascript function" as action type, then input Function as "testLightBox("Hello, this is 

a test"): 
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And then make sure the Javascript wrote into the index.html page as below image shows (the 

same as you set in "Link Function"): 

 

 

2. Add Movie: 

 

Click icon  and then draw a box like below on the page you want to insert FLV movie: 
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Then you can select and edit the movie in below panel: 

  

 

3. Add Sound: 

 

Click the icon  to draw sound box and then select sound file, set other options: 

 



PDF to Professional Page-Flipping eBook Utility 

User Document 

Copyright 2010 by flippagemaker.com 

- 28 - 
 

 

4. Add Flash: 

 

Click icon  to insert SWF flash into your defined area of flipbook page: 

 

 

After adding links, flash, movie or sounds, you can click the icon  to save the settings and 

back to the template setting interface. 
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V. Language Options Interface 

Click "Option->Flash Language", you will enter into the Language Settings interface as below 

shows: 

 

Panel Description: 

As the tips explaining, the "Labeled" column lists the buttons and instructions on Flash books 

in defined language, and the program provides you five different languages for you to use: 

English, Chinese Arabic, French and Greek.   
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You can also add other language for your own uses: 

1. Click the button  and define name for the new language: 

 
Click "OK" to save the new language in the list; 

2. Choose the first label and click "Edit" icon, define new language text in "Labeled" box, 

then click "Save And Edit Next": 

 
 

3. At last, you can get all Labels translated into your new language as the images shows: 
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You can delete unwanted language:  

Or save your edited new language file as XML or TXT file:  

Load language file saving before for current using:  

 

 

After setting template and language, click  icon to 

apply the settings. 

 

VI. Output Interface 

 

 

Output types: 

1. HTML 

 

This output type is for uploading created page-flipping ebook onto websites: 

 

You can define HTML Title and other properties by clicking "Advanced" button:  
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Set Keywords, Description or even Script in the below interface: 

 

2. ZIP 

 
This output type is for compressing the created files into an integral ZIP package which can 

be sending out as attachment directly. You can also define HTML Advanced Settings by 

clicking "Advanced" icon:  

Your recipients just need to uncompress the ZIP file and then they can view the HTML 

flipbook instantly: 

 

3. EXE 

 

This type is for outputting flipbook as a single executive file, easy storing and easy viewing:  

 

You can also define Icon and Opening Window Size in Advanced Settings: 
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You can even burn the output flipbook to CD: 

 

After choosing output type, then check the option "Burn to CD", set "CD Writer", define 

"Disc title", at last click button to output flipbook in your defined type. 

VII. Batch Convert Interface 

 

 

Panel Description: 
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1. Add PDF Documents 

Click this icon to add PDF files from computer; 

 Click this icon to add all PDF files in the folder (include sub-folders). 

 

You can also remove some unwanted PDF, move up/ down files, or clear all documents.  

 

 

2. Settings 

 

(1). Output Settings 

  i. Choose Output Type 

 

 

  ii. Choose Output Path 

 

 
 

You can also define output name pattern with FileName, Title, Subject and so on: 

 

 

And after defining the File Name, you can preview the result example below: 

 

 

  iii. Define Output Option 

 

Click "Advanced" icon to define Keywords, Description for HTML flipbooks, or define Icon, 

Window Size for EXE flipbooks: 
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  iv. Merge All PDF Files to One Flip Book 

 

 

 

(2). PDF Settings 

  i. Page Range 

 

 

You can convert "All pages" or just "Custom range"; 

 

  ii. Watermark 

 

 

Click "Set Watermark" icon to enter into "Watermark" interface: 
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Check "Applying Watermark" option, then you can choose default stamps, Edit them, or Add 

Text Watermark, Add Image Watermark, Delete, Move Down/ Up. 

  iii. Page Quality 

 

Choose quality and size type from listed five kinds. 

 

  iv. Other Options 

 

 Select this option to use first page's 

proportion as book proportion, or you can define in Template Setting interface; 

 

If your PDF file contains bookmarks, check this option to use in output 

page-flipping eBook; 

 

If your PDF file has links, check this to enable in flipbook; 

Check this option to enable search functionality in created flipbook. 



PDF to Professional Page-Flipping eBook Utility 

User Document 

Copyright 2010 by flippagemaker.com 

- 37 - 
 

 

 

 

At last, click  icon to batch convert listed files together. 

 

 

 

 

 

 

 

 

 

 

 

 

 

VIII. Use FlipBook Creator Pro in Command Line 

You can also use FlipBook Creator Pro in Command Line. 

 

FlipBook Creator Professional Command Line Usage: 

 

 PTCMD.exe [Options] 

 

 -f<PDF File>           The source PDF file. 

 

 -o<output folder>      Specify the folder for the output files. 

 

 -t[html|zip|exe]       Output type. Default is html. 

 

 -n<OutputFileName>   Specify the name for the output file. 

 

 -c<caption>           Caption for HTML or EXE. 

 

 -s<Flash settings>      Value format is:<Template name>#[<Theme name>| 

                     <txt_settingfile path>]. 

                     <Template name> could be: Classic, Float, Spread. 

                     <Theme name> are list in the "Select a template" window, 
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                     such as Blank,Blues,Nostalgia. 

                     <txt_settingfile path> is the file that you export 

                     with "Save the template settings" function 

 

 -r<page range>.       The page range that you want to import from PDF File. 

                     Range value string like:2-15,33,35-36,or All.(Default: All) 

 

 -q<import quality>     Count be 5,4,3,2,1.5 specify the higher quality larger file 

                     size;1 specifies lower quality smaller file size.(default:4) 

 

-R<GS|SWF|LIB>       Render engine options. (Default: GS, Ghostscript render                                                                           

engine)                                              

 

 -b<Y|N>             Import bookmark yes or no. (Default: Y) 

 

 -l<Y|N>              Import links yes or no. (Default: Y). 

 

 -S<Y|N>             Enable searchable or not.(Default: Y, enable searchable) 

 

 -k<html key words>    Set the keywords for html output file. 

 

 -d<html description>   Set the descriptions for html output file. 

 

 -j<html javascript>     Set the javascript for html output file. 

 

 -i<icon file path>      Specify the icon path for exe output. 

 

 -w<window size>      Specify the size of exe window. 

                     Value could be: M,F, or some string like:800,600. 

                     (width is 800,height is 600). 

 

 

 Examples 1: 

 PTCMD -f"C:\input.pdf" -o"C:\outputfolder" -n"index" -thtml -c"Title" 

-s"Float#c:\my_ebooksetting.txt" -r"1-8,9-14,42" -q4 -R"SWF" -bN 

 

 Examples 2: 

 PTCMD -f"C:\input.pdf" -o"C:\outputfolder" -n"ExeFileName" -texe -i"C:\app.ico" 

-c"Title" -s"Float#Blues" -r"All" -q5 -R"GS" 

 

 Examples 3: 

 PTCMD -f"C:\input.pdf" -o"C:\outputfolder" -n"index" -tzip -c"Title" 

-s"Float#Blank" -r"All" -q5 -R"GS" -k"html key words"\ 
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License Agreements   

 

All copyrights to FlipBook Creator Pro (the Software) are exclusively owned by 

flippagemaker.com. For more information, visit our website at www.flippagemaker.com . 

 

Anyone may use this software but all the page-flipping eBooks generated will automatically 

have a demo watermark on the first page of them. To remove the limitation you must 

register. 

 

Once registered, the user is granted a non-exclusive license to use the Software on one 

computer (i.e. a single CPU) at a time. The registered Software may not be rented or leased, 

but may be permanently transferred, if the person receiving it agrees to terms of this 

license.  

 

The Software unregistered (trial) version may be freely distributed, provided the distribution 

package is not modified. No person or company may charge a fee for the distribution of the 

Software without written permission from the copyright holder.  

 

THE SOFTWARE IS DISTRIBUTED "AS IS". NO WARRANTY OF ANY KIND IS EXPRESSED OR 

IMPLIED. YOU USE AT YOUR OWN RISK. THE AUTHOR WILL NOT BE LIABLE FOR DATA LOSS, 

DAMAGES, LOSS OF PROFITS OR ANY OTHER KIND OF LOSS WHILE USING OR MISUSING THIS 

SOFTWARE. 

 

 

 

Return Code: 

1:  Success 

2:  Input file not found 

3:  Parameters are invalid 

4:  Failed to load PDF 

5:  Failed to import bookmarks 

6:  Failed to import links 

7:  Failed to import searchable information 

8:  Failed to save the output file. 
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You may not use, copy, emulate, clone, rent, lease, sell, modify, decompile, disassemble, 

otherwise reverse engineer, or transfer the licensed Software, or any subset of the licensed 

Software, except as provided for in this agreement. Any such unauthorized use shall result in 

immediate and automatic termination of this license and may result in criminal and/or civil 

prosecution. 

 

All rights not expressly granted here are reserved by A-PDF Solution. 

 

Installing and using the Software signifies acceptance of these terms and conditions of the 

license. 

 

If you do not agree with the terms of this license you must remove the Software files from 

your storage devices and cease to use the product. 

  

 

How to Order 

 

Order Online (http://www.flippagemaker.com/flippingbook-maker-pro\index.html) or Order 

Toll Free 1-877-353-7297 (When you order toll free just give the operator the product 

number of the product you would like). 

 

How to purchase online?  

 

1. Select a license type above, and click [Buy Now] 

 

2. Select the currency that you want to use. (You can also continue shopping) 

 

3. Fill billing information and select a payment method. (Your information is safe with us) 

 

4. Check the information you filled previously and click "Place Secure Order"  

 

Other Order Ways—With Phone/Mail/Fax/Check: 

 

If you are not comfortable ordering online with a credit card, you are welcome to choose an 

offline order option in the payment section of the order process. We accept mail, fax, wire, 

and PO (if applicable) ordering options in addition to ordering online. We also provide 

phone orders through our 24x7 order desk at 1-877-353-7297, or (952) 646-5331 for 

International Callers.  
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Please note that all of the offline ordering options do have additional fees for processing. To 

place an order by mail, fax, wire, and PO (when applicable), use the online form and then 

choose one of these payment options found in the Payment Method section of the form. 

Once submitted online, the appropriate information will be provided to you in your web 

browser to send your payment to us offline. 

 

100% unconditional 30 Day Money Back Guarantee 

 

 

Want to custom the program or have other questions about purchase? 

Contact us at support@flippagemaker.com . 

 

 

 

Support 

You can easily search or browse our frequently asked questions, and learn tutorials about 

products, and get your registration code back. If you are not satisfy with the solutions 

provided, please contact support team for help. 

 

1. Frequently Asked Questions 

You can find answers to questions about technique issues here: http://www. 

flippagemaker.com/  

2. Learn tutorial about FlipBook Creator Pro 

We publish a video tutorial which shows you the easy procedure of dealing with FlipBook 

Creator Pro, you can view this video to quickly handle the stunning tool: 

http://www.flippagemaker.com/flippingbook-maker-pro/flippingbook-creator-pro.swf 

3. Get lost license code 

Click here to look up the order » (http://www.regnow.com/cs/orderStatus) 

You can pull up a copy of your order by entering your email address. After you find your 

order, you may view its status, view details of your order (including the license key), and 
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obtain the invoice.  

 

4. Contact Us  

If you have other questions or requirements, contact us directly through our support Email: 

support@flippagemaker.com, we will respond you ASAP. 
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